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Introduction
It may be hard to imagine, but once upon a time, pages on the World Wide Web didn’t
have pictures, let alone animations, videos, and interactive graphics. All these elements
were added through trial, error, debate, and debunk. Changes came when brave souls
(like you) forged ahead and made things work with the tools at hand. If a commercial
product worked well and was widely adopted, it became the de facto standard. Adobe’s
PDF (portable document files) and Flash animation player are well-known examples.
However, there’s always been a problem with proprietary and patent-encumbered
technologies on the Internet. They’re like a toll road in the center of a major city. On the
other hand, authorities and standards-writing groups have been known to create
“standards” that few browser and web developers follow. Strictly structured XHTML
pages fall into this category. The solution is to create standards for the Internet that are
practical, usable, and don’t stifle creativity. Of course, that’s easier said than done.
With HTML5, the standards-writing crowd (also known as the W3C) is working hard to
give the Internet community a roadmap that takes into account where we’ve been and
where we’re heading. There are a number of exciting new features in HTML5, but
perhaps most visible are the new ways to present and animate graphics. If you’re
thinking, “That sounds a lot like Adobe Flash,” you’re right. One shiny new feature of
HTML5 provides a non-proprietary, standard way to change graphics, color, size, shape,
and position over time. The technique uses newly defined HTML tags, the power of
JavaScript, and its jQuery companion library. These open-source technologies are
available to everyone, whether they’re designing web pages or building the next great web
browser.

Why Use Adobe Edge Animate?
If you need a compelling reason to learn yet another animation technology, here are three
good ones: iPhone, iPod, and iPad. In fact, if you’re a Flash designer or developer, you’re
probably already dialed in to the famous debate between Apple and Adobe regarding
Flash. As a web designer and developer, more important than the debate is the fact that
Flash content on web pages can’t be viewed by the most popular mobile devices on the
planet. However, if you use HTML5 and JavaScript, you can capture that Apple audience
and more.
So why should you use an Adobe product to create HTML5 web content? It’s an
understatement to say that most graphic artists view the world differently from computer
programmers. If you’re an artist, you may not be entirely comfortable describing each
circle, color, and line in your artwork by typing out JavaScript code, even though it’s
theoretically possible. You’re probably more inclined to use a tool that reminds you of
Adobe Illustrator, Photoshop, or Flash. That’s exactly where Animate fits in. Animate
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has a timeline like the ones in Flash and After Effects. The Elements and Properties
panels will remind you of your favorite drawing and photo tools. If you use Animate to
develop HTML5 graphics, then you can concentrate on creating and fine-tuning your
artwork. Animate will generate the HTML5 and JavaScript/jQuery code that’s needed
for your web pages.
NOTE
Although “Adobe Edge Animate” is the program’s formal name, in this book you’ll often see “Animate” for
short.

Where to Find Adobe Edge Animate
If you don’t already have Adobe Edge Animate on your computer, you can get Version
1.0 from Adobe as part of a free Adobe Cloud membership. Go to
http://html.adobe.com/edge/animate/. Click the Get Started button. You know the drill.
Provide your name, email address and a password and you’re signed up. If you want
more details on how to install Animate on your computer, check out Appendix A.

About This Book
Despite the many improvements in software over the years, one feature has grown
consistently worse: documentation. With the purchase of most software programs these
days, you don’t get a single page of printed instructions. To learn about the hundreds of
features in a program you’re expected to use online electronic help, but with a brand new
product, like Adobe Edge Animate, the help files are minimal.
But even if you’re comfortable reading a help screen in one window as you try to work in
another, something is still missing. At times, the terse electronic help screens assume that
you already understand the discussion at hand and hurriedly skip over important topics
that require an in-depth presentation. In addition, you don’t always get an objective
evaluation of the program’s features. (Engineers often add technically sophisticated
features to a program because they can, not because you need them.) You shouldn’t have
to waste your time learning features that don’t help you get your work done.
The purpose of this book, then, is to serve as the manual that should have been in the
box. In this book’s pages, you’ll find step-by-step instructions for using every Animate
feature, including those you may not even have quite understood, let alone mastered,
such as moving the HTML5 and JavaScript code into your web pages or making changes
to existing pages using Animate. In addition, you’ll find clear evaluations of each feature
that help you determine which ones are useful to you, as well as how and when to use
them.
NOTE
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This book periodically recommends other books, covering topics that are too specialized or tangential for a
manual about Animate. Careful readers may notice that not every one of these titles is published by Missing
Manual-parent O’Reilly Media. While we’re happy to mention other Missing Manuals and books in the O’Reilly
family, if there’s a great book out there that doesn’t happen to be published by O’Reilly, we’ll still let you know
about it.

Adobe Edge Animate: The Missing Manual is designed to accommodate readers at every
technical level. The primary discussions are written for advanced-beginner or
intermediate computer users. But if you’re a first-timer, special sidebar articles called Up
to Speed provide the introductory information you need to understand the topic at hand.
If you’re an advanced user, on the other hand, keep your eye out for similar shaded boxes
called Coders’ Clinic and Designer’s Toolbox. They offer more technical tips, tricks, and
shortcuts for the experienced computer fan.

Macintosh and Windows
Animate works almost precisely the same in its Macintosh and Windows versions. Every
button in every dialog box is exactly the same; the software response to every command
is identical. In this book, the illustrations have been given even-handed treatment,
rotating between the two operating systems where Animate is at home (Windows 7 and
Mac OS X).
One of the biggest differences between the Mac and Windows versions is the keystrokes,
because the Ctrl key in Windows is the equivalent of the ⌘ key on the Mac.
Whenever this book refers to a key combination, you’ll see the Windows keystroke listed
first (with + symbols, as is customary in Windows documentation); the Macintosh
keystroke follows in parentheses (with - symbols, in time-honored Mac fashion). In other
words, you might read, “The keyboard shortcut for saving a file is Ctrl+S (⌘-S).”

About the Outline
Adobe Edge Animate: The Missing Manual is divided into three parts, each containing
several chapters:
Part 1 starts off with an introduction to the Animate workspace. You’ll learn some
more details about how Animate performs its magic by creating HTML, JavaScript,
and CSS code. Then you’ll roll up your sleeves and create graphics within Animate
and import artwork from other programs. Along the way, you’ll begin to work with
Animate’s Timeline and Properties panel to make things move. Chapter 3 is devoted
to working with text and you’ll see how easy it is to make text elements change size,
shape, and color.
Part 2 is all about animating the elements on the stage. You’ll learn advanced
techniques for working efficiently in Animate. Animation is time-consuming work,
but you can save lots of time by reusing and recycling your previous work with
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symbols. You’ll learn to manage and edit the timeline and the transitions you create.
One chapter in this section is devoted to triggers and actions. You use these tools to
automate your animation and give interactive control to your web pages. The last
chapter is devoted to Animate symbols, a handy tool for grouping elements and
reusing art and code. Symbols speed up the development process and add consistency
to your compositions.
Part 3 gets into the nitty-gritty details of working with code. This book doesn’t
attempt to be an advanced JavaScript programmer’s manual. Instead, you’ll learn how
to selectively tweak bits of code to make some animation magic. Some of the most
interesting projects are covered in this chapter, where all the skills learned in the
previous chapters come in to play.
Part 4 helps you deliver your Animate masterpiece to an audience—that’s done by
publishing your composition. In this section, you learn how to develop responsive
designs that look good whether they’re viewed on a desktop computer, a smartphone,
or a high-def TV. You’ll also learn how to accommodate browsers that aren’t up to
date with HTML5 capabilities.
Appendix A explains how to install Animate on both Windows and Mac computers.
You’ll also find tips on where to look for discussions and additional Animate resources.
Appendix B: Menu by Menu briefly describes each menu command and its function.

The Very Basics
You’ll find very little jargon or nerd terminology in this book. You will, however, come
across a few terms and concepts that you’ll encounter frequently in your computing life:
To use this book (and indeed to use Adobe Edge Animate), you need to know a few
basics. This book assumes that you’re familiar with a few terms and concepts:
Clicking. This book includes instructions that require you to use your computer’s
mouse or trackpad. To click means to point your cursor (the arrow pointer) at
something on the screen and then—without moving the cursor at all—press and
release the left button on the mouse (or laptop trackpad). To right-click means the
same thing, but pressing the right mouse button instead. (Usually, clicking selects an
onscreen element or presses an onscreen button, whereas right-clicking typically
reveals a shortcut menu, which lists some common tasks specific to whatever you’re
right-clicking.) To double-click, of course, means to click twice in rapid succession,
again without moving the pointer at all. And to drag means to move the cursor while
holding down the (left) mouse button the entire time. To right-drag means to do the
same thing but holding down the right mouse button.
When you’re told to Shift-click something, you click while pressing the Shift key.
Related procedures, like Ctrl-clicking, work the same way—just click while pressing
the corresponding key.
12

Menus. The menus are the words at the top of your screen: File, Edit, and so on.
Click one to make a list of commands appear, as though they’re written on a window
shade you’ve just pulled down. Some people click to open a menu and then release
the mouse button; after reading the menu command choices, they click the command
they want. Other people like to press the mouse button continuously as they click the
menu title and drag down the list to the desired command; only then do they release
the mouse button. Both methods work, so use whichever one you prefer.
Keyboard shortcuts. Nothing is faster than keeping your fingers on your keyboard
to enter data, choose names, trigger commands, and so on—without losing time by
grabbing the mouse, carefully positioning it, and then choosing a command or list
entry. That’s why many people prefer to trigger commands by pressing combinations
of keys on the keyboard. For example, in most word processors, you can press Ctrl+B
to produce a boldface word. In this book, when you read an instruction like “Press
Ctrl+L to insert a label,” start by pressing the Ctrl key; while it’s down, type the letter
L; and then release both keys.

About→These→Arrows
Throughout this book, and throughout the Missing Manual series, you’ll find sentences
like this one: “Open the System Folder→Preferences→Remote Access folder.” That’s
shorthand for a much longer instruction that directs you to open three nested folders in
sequence, like this: “On your hard drive, you’ll find a folder called System Folder. Open
that. Inside the System Folder window is a folder called Preferences; double-click it to
open it. Inside that folder is yet another one called Remote Access. Double-click to open
it, too.” Similarly, this kind of arrow shorthand helps to simplify the business of choosing
commands in menus, as shown in Figure 1.

Figure 1. When you read in a Missing Manual, “Choose Edit→Paste Special→Paste Inverted,” that
means: “Click the Edit menu to open it. Then click Paste Special in that menu; choose Paste Inverted in the
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resulting submenu.”

About the Online Resources
As the owner of a Missing Manual, you’ve got more than just a book to read. Online,
you’ll find example files so you can get some hands-on experience, as well as tips,
articles, and maybe even a video or two. You can also communicate with the Missing
Manual team and tell us what you love (or hate) about the book. Head over to
www.missingmanuals.com, or go directly to one of the following sections.

Missing CD
This book doesn’t have a CD pasted inside the back cover, but you’re not missing out on
anything. Go to www.missingmanuals.com/cds/animatemm to download all the examples
and exercises that are covered in this book. You can download all the files in one big ZIP
file or you can download the files chapter by chapter. Most examples are made up of
several files, which might include a web page (.html), images (.jpg), JavaScript code (.js),
and style sheets (.css), so it’s important to keep the files and their folders together or the
examples may not work. Example and exercise folders and files are numbered, so when
you see 03_2-MyExample, you’ll know that this example is from Chapter 3 and it’s the
second folder for the chapter.
For many of the exercises, there are completed examples that you can use to check your
own work. A completed example includes the word done in the filename as in 033_MyExample_done.
Finally, so you don’t wear down your fingers typing long web addresses, the Missing CD
page also offers a list of clickable links to the websites mentioned in this book.

Registration
If you register this book at oreilly.com, you’ll be eligible for special offers—like
discounts on future editions of Adobe Edge Animate: The Missing Manual. Registering
takes only a few clicks. To get started, type http://oreilly.com/register into your browser
to hop directly to the Registration page.

Feedback
Got questions? Need more information? Fancy yourself a book reviewer? On our
Feedback page, you can get expert answers to questions that come to you while reading,
share your thoughts on this Missing Manual, and find groups for folks who share your
interest in web design and animation. To have your say, go to
www.missingmanuals.com/feedback.

Errata
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In an effort to keep this book as up-to-date and accurate as possible, each time we print
more copies, we’ll make any confirmed corrections you’ve suggested. We also note such
changes on the book’s website, so you can mark important corrections into your own
copy of the book, if you like. Go to http://tinyurl.com/animate-mm to report an error and
view existing corrections.

Safari® Books Online
Safari® Books Online is an on-demand digital library that lets you easily search over
7,500 technology and creative reference books and videos to find the answers you need
quickly.
With a subscription, you can read any page and watch any video from our library online.
Read books on your cellphone and mobile devices. Access new titles before they’re
available for print, and get exclusive access to manuscripts in development and post
feedback for the authors. Copy and paste code samples, organize your favorites,
download chapters, bookmark key sections, create notes, print out pages, and benefit
from tons of other time-saving features.
O’Reilly Media has uploaded this book to the Safari Books Online service. To have full
digital access to this book and others on similar topics from O’Reilly and other
publishers, sign up for free at http://my.safaribooksonline.com.
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Part 1. Working with the Stage
Chapter 1
Chapter 2
Chapter 3
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Chapter 1. Introducing Adobe Edge
Animate
Travelers on the World Wide Web expect strong graphics. They appreciate animation
that contributes to the subject as long as it doesn’t waste their time. Done well, animation
draws attention to important details, shows how things work, and helps site navigation.
But, graphics certainly weren’t first and foremost when the Web was created. The
language used to display web pages is called HTML—short for HyperText Markup
Language. Like any language, HTML has evolved and continues to adapt to current
needs and new ideas. The latest step in that evolution is HTML5, which combined with
other technologies like CSS3, JavaScript, and jQuery, presents the beautiful interactive
pages you visit today.
Instead of creating graphics and visual effects manually by writing code, artists can use
Adobe Edge Animate—a tool that’s a much better fit for designers. This chapter starts
off by explaining how Animate works to write HTML code that a web browser can read.
Then it offers a quick introduction to the main parts of the Animate workspace. Finally,
you’ll take Animate for a test drive, where you’ll make an image move and create text
that fades in and out. Your first hands-on experience will be quick and easy. Consider
this first adventure an overview—the following chapters will reveal the details.

Creating and Saving Edge Animate Projects
Animate’s role in life is to help you make web pages that come alive with motion. You
design the graphics using familiar visual tools, while Animate writes the underlying code.
It’s as if you hired an HTML/CSS/JavaScript/jQuery coder for your design team. One
good way to understand what goes on behind the scenes is to create and save an empty
Animate project. Fire up Edge Animate as you would any other application on your
computer. That means the process is slightly different for Windows and Mac computers.
If you plan on using Animate a lot (and why wouldn’t you?) you can use any of the
familiar tricks to create handy shortcuts. In Windows, you can pin an Animate shortcut to
your Start menu or the taskbar. On a Mac, you can add Animate to the Dock.
When you first start Animate, you’re greeted by a splash screen. On the right side of the
screen, you see links to lessons and other Adobe resources. On the left are links to create
a new file or open previously created files. Click Create New and then, once Animate is
running, you reach a workspace with a number of panels and more links to Adobe
lessons. Don’t worry about those details now; you’ll explore them later in this chapter.
Create a new folder on your computer desktop and call it Edge Barebones. Next, do the
project creation two-step. Go to File→New and then File→Save As. Find the Edge
Barebones folder on your desktop and save your project with any name you want. Now,
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examine the contents of the folder. You’ll find five files and a folder like the ones in
Figure 1-1. If you’ve spent time developing web pages, you’ll see some of the usual
suspects and maybe a newcomer or two:
The .an file is used by Animate to keep track of your project.
The .html file describes a web page using HTML code, like any of the gazillion web
pages on the Internet.
The .js files hold JavaScript code that’s specific to your project. Right now your
project is barebones, but the code defines the empty animation stage and performs
other tasks that are necessary for all Edge Animate projects.
Open the folder that’s named edge_includes, and you’ll find more JavaScript files. These
are libraries of JavaScript code. One is specific to Animate; the others are standard
JavaScript libraries. These libraries are referenced by the code in the HTML page that
Animate created. They serve as the engine behind your Animate project. In short, they
make things move.
Unlike a word processor or a spreadsheet, which create single files, Animate creates
several files, and it needs those files to build the project and to display your masterfully
designed page in a browser. If you delete or move one of these files, chances are you’ll
confuse Animate and anyone who views the web page. So one thing to learn from this
bare-bones exercise is proper folder and file management:
Create separate folders for each project you tackle, including the exercises in this
book. (You may want to put them all in a main Animate project folder.)
Don’t delete, move, or rename the files and folders that Animate creates until you
fully understand their relationships.
NOTE
Actually, all your projects could share the files in the edge_includes folder. For now, it’s easiest to let Animate
create new files for each project. They don’t take up that much storage space on your computer.
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Figure 1-1. Animate automatically creates several files and folders as you work. It’s important not to move,
delete, or rename these files, or your animation won’t work as expected. You add your work to a website by
copying these files to the web server.

A Tour of the Animate Workspace
Once you’ve gone past the splash screen by creating a new file or opening an old one,
you see a workspace with several panels and a small toolbar, as shown in Figure 1-2. The
name for each panel appears on a tab at the top. The Elements, Properties, and Timeline
panels and the Tools toolbar all hold tools and widgets you use to create your animation
masterpieces. The largest panel is the stage, where you build your animation. Its tab
displays the name of your project.
The stage is where you display and animate the graphics and text for your web page
audience. When you save your project, Animate records the text and graphics and
saves the description as a web page in HTML code. Open the page in a browser, and
it plays back just as it appeared on the Animate stage. The stage has defined
boundaries, and it’s possible to hide or position elements so that they are offstage.
Elements are objects that you add to the stage, and as a result they appear on your
finished web page. Elements may be artwork, photographs, or text.
Elements have properties that affect their position and appearance on the stage. You
manage those properties using the Properties panel.
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The Timeline keeps track of elements and their properties over the course of time.
When an element’s properties change, that may change its position on the stage and
its appearance.
The Library keeps track of images that you import into your project. It provides easy
access to the symbols that you create in Animate.
Tools appear at the top of the main workspace. You use these to create, select, and
modify elements on the stage. It’s a small toolbox, but you may be surprised at how
much it can do.
The Lessons panel at right provides links to Adobe’s introductory lessons, which can
be helpful when you’re starting out. The right panel gives you step-by-step
instructions, with the results appearing in a sample file on the stage. After you’ve
checked out the lessons, click the X on the Lessons tab to hide it and recover some
valuable workspace.
TIP
You may think of these workspace boxes as panels or palettes, but Adobe lists them all under the Window
menu, where you can show or hide each with a mouse click.

Figure 1-2. The Animate workspace consists of a few movable and resizable panels. Top, center is the stage,
which you use as your canvas to display the graphic elements in your animation.
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